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GEOPAK Road for Bridge  Introduction 

I.1 Introduction 
GEOPAK is a comprehensive software package that covers every project phase from 
conceptualization to final quantities.  The software works within the MicroStation graphic 
environment providing true interactive design.  For example, a horizontal alignment can be 
created graphically, it can be calculated with the coordinate geometry component of GEOPAK or 
some interactive combination of the two.  Dynamic on-screen design provides immediate 
interpretation of plan view geometrics for making design choices through visualization. 
 
Using GEOPAK will help ensure consistency and accuracy of design work and generate 
significant timesaving in the overall effort of producing construction plans. 
 
 
For GEOPAK support, please contact the CADD Support Center. 
 

I.2 File Names 
GEOPAK uses and/or creates files during the design process.  The files you need to be familiar 
with are listed below:  
 
job###.gpk This binary file is created when the user starts a coordinate geometry (COGO) 

session for the first time or through Project Manager and may be appended to 
during the design process. All coordinate geometry elements are stored in this 
file. Multiple users can access this file at the same time, and only one file 
should be created for each project.  The "###" is the only variable in this name.  
It represents a job number (up to 3 alphanumeric characters) unique to a 
project and is defined by the user upon creation.  MoDOT users should use the 
last 3 digits of the job number.  Example J1P0999 -> job999.gpk 

 
fname.inp  Any ASCII input file for running GEOPAK processes. Name is user defined 

with a .inp extension. Example: shape.inp 
 
fname.log ASCII file used to capture results from processing input files, proposed cross 

sections, and earthwork. 
 

fname###.ioc  ASCII input file for loading data during a COGO session. "###" represents the 
job number and "oc" is the operator code (users initials). Example: 
align999.iho 

 
fname###.ooc  ASCII output file created by GEOPAK during a COGO session. Variables are 

the same as defined above. Example: align999.oho 
 
fname.dat A binary file that contains string and point information to be used for digital 

terrain model construction. 
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fname.tin A binary file containing triangular surfaces also known as the digital terrain 

model (DTM) 
 
project.prj Binary file resulting from the creation of a new project. 
 

I.3 Accessing GEOPAK Road 
GEOPAK is 
started upon 
entering a 
MicroStation 
File with 
User: set to 
design, as 
shown in the 
dialog to the 
right.  To 
verify that 
GEOPAK is 
active, scan 
the 
MicroStation 
menu bar 
where the 
Applications 
menu appears.  
Simply pull 
down 
Applications 
> GEOPAK 
Road.  When 
each 
GEOPAK tool is selected, the corresponding dialog will appear.  To utilize the full potential of 
GEOPAK, usage of the GEOPAK dialogs may be interspersed with generic MicroStation 
commands.  In addition, several dialogs may be opened simultaneously. 
 
To close a dialog, simply click the X in the upper right corner of the dialog.  In addition, the 
Coordinate Geometry dialog and Design and Computation Manager may be closed by selecting 
the File > Exit option.  Other various dialogs will have a Cancel button, which will exit the 
dialog.  Exiting the MicroStation file automatically closes all GEOPAK dialogs. 
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I.4 User Preferences 

 
 

The User Preferences dialog is used to set items that determine how distances, directions, and 
stationing is displayed and calculated, as well as the units that are used.  The User Preferences 
dialog can be accessed from Applications>>Geopak Road>>User Preferences.  The following 
dialog appears. 
 
Most of the settings in this dialog will be set when the project is setup.   
 
The Working Directory is used to tell Geopak where the data files for a particular project can 
be found.  If a user does not want to work within a specific project, they can delete the 
information out of this field, and Geopak will use the directory that the open MicroStation file is 
located in. 

I.4.1 Feature Preferences 
The Feature Preferences button will 
activate the following dialog. 
 
The SMD File is used to control the 
symbology of survey elements.  Users 
will not be able to edit the SMD File, 
however, the Edit SMD… button can be 
used to view the feature codes.  The 
Apply Best Match Feature toggle should be checked to allow for proper import of survey data.  
The scale of the features can be controlled using the Plot Scale.  This should be set to the scale 
of the plan sheets to be created. 
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I.4.2 COGO Preferences 
The COGO Preferences button will activate the following dialog. 

 
The Job Directory can be set to indicate the location of the coordinate geometry database (.gpk).  
If this field is not set, GEOPAK will look for the coordinate geometry database (.gpk) in the 
Working Directory.  The COGO Input File Dir. and COGO Output File Dir. can be set to 
indicate the location of the COGO input and output files respectively.  If these fields are not set, 
GEOPAK will look in the Job Directory.   
 
The Redefinition of Elements toggles on or off the COGO redefine option.  This option is 
discussed further in Chapter 5.  The Force redefinition off at Cogo Activation will turn the 
COGO redefine toggle off whenever GEOPAK’s coordinate geometry tools are activated. 

I.4.3 Superelevation Preferences 
There are two options for using GEOPAK Superelevation, GEOPAK 2000 and Classic.  
GEOPAK 2000 will use the tools made available in GEOPAK 2000 and later versions.  The 
Classic option will bring up the tools available prior to GEOPAK 2000.   
 
**Note: The Classic option will not be supported within MoDOT.  Only the GEOPAK 2000 
option will be supported. 
 
The Superelevation Preferences have been set by CADD Support and do not need to be 
modified by the user.   

I.4.4 Plan & Profile Sheets Compatibility 
Three options are available for creating Plan & Profile Sheets, Classic, GEOPAK 2001+, and 
GEOPAK 2001+ with Raster Manager.  At the present time only the Classic Plan & Profile 
Sheets tool is configured to MoDOT standards.  Consequently the user should choose Classic. 
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1.1 Objectives 

• Be able to start a new Geopak job with the Start Job dialog. 

1.2 Definition 

Start Job is a tool that will set up a Geopak job for a user, or add users to an existing job.  Start 
Job will create the job directories, copy default MicroStation files to the directories, and set the 
global origin in the MicroStation files.  Start Job will also append the job number to the end of 
the copied MicroStation files.  Once a job has been created, Start Job will add a user to the job.  
Start Job is only available in the design user interface in MicroStation. 

1.3 Accessing 

Start Job can be accessed from the MicroStation menu MoDOT>>Start Geopak Job/Add 
User. 

1.4 Start Job Dialog 

Once the user has accessed the Start Job 
dialog box, shown right, they will need to 
fill in or choose the Job Number and the 
Path in which to place the job directory.  
Once the job number and path have been 
chosen, the District and County can be 
chosen. 
 
If the user is creating a new job, do not 
check the Add Users to Existing Job 
toggle, just choose the userids of the people 
that will be working on the job.  If a job 
already exists, and the users are being 
added to the job, check the Add Users to 
Existing Job toggle. 
 
For a new job, select the Units and the 
Sheet types that will be used for the job.  
This will create a directory for each Sheet 
type selected to place the sheets into as 
they are created. 
 
If the job is not based on the modified state 
plane or the state plane coordinate systems, Custom Coordinates must be set to shift the global 
origin.  If the modified state plane or state plane coordinate systems were used for the project, 
the County selected will determine the global origin shift. 
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Once all fields have been filled in, select the OK button.  The job directories will be set up as 
shown below. 
 

T:\ 
 br-proj\ 
 A_Geopak\ 
 D# (last digit of district number) 
 job number 
     data 
               dtm.dgn 

          pattern_shape.dgn 
          plan.dgn 

               profile.dgn 
               topo.dgn 
               xs.dgn 
     plan_sheets 
               100 
               20 
     project 
               projdbs 
                userid1 
                userid2 
 
 
The data directory contains any project data.  This is the directory that contains the MicroStation 
drawings, the Geopak coordinate geometry database (.GPK), and any input or output files.  The 
plan_sheets directories contain the detail sheets drawn at specific scales for the project.  The 
project directory contains the Geopak project manager file (.PRJ), and the userid directories.  
The userid directories contain the user runs for the job. 
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2.1 Objectives 

• Learn how to set up a project using Project Manager. 
• Learn how to utilize Project Manager as a workflow guide. 
• Learn how to access GEOPAK dialogs from the Project Manager. 

2.2 Definitions 

Project Manager is a GEOPAK tool that associates a project with its respective gpk job number, 
users, working directories and project files.  Project Manager provides the user with an easy 
workflow system that keeps records of processes run throughout the design of a project. 

2.3 Accessing 

To access Project Manager: 
•  Select Applications >> GEOPAK 
Road >> Project Manager (as shown 
in the figure to the right) or  
 

•  Select the Project Manager icon 
from the GEOPAK Road Tools 
(both are shown to the left), 
which are opened by selecting 
Applications >> GEOPAK 
Road >> GEOPAK Road 
Tools.   

 
The following dialog depicted to the right appears:  

2.4 Project Manager Dialog 

2.4.1 General Description 
The current directory is displayed at the top of the 
dialog box, which can be changed by navigating to 
a different directory in the Directories list box.  
This navigation is the first step in selecting an 
existing project or creating a new one.  Project 
files (.prj) are displayed in the Projects list box.  
The project files should be located in the  
t:\br-proj\A_Geopak\district\jobnumber\project 
directory. 
 
The remainder of the Project Manager dialog box 
displays information after a project has been 
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selected from the Projects list box.  At the bottom of the dialog are the OK and Cancel buttons.  
If the user wishes to exit Project Manager, the Cancel button should be selected.  To continue in 
the Project Manager process, the OK button should be selected. 

2.4.2 Project Manager Menu Bar 
There is three pull down choices on the Menu Bar: Projects, Directory, and Admin.  Each of 
these choices has options contained in the pull down. 

2.4.2.1 Project Tools 
There is four choices under the Projects pull 
down: New, Edit, Delete, and Exit as shown 
below. 
 
As can be seen from this dialog box, the Windows 
motif also keeps track of the last few processes that 
have been executed.  These may be recalled as 
needed by selecting the desired process.  

2.4.2.1.1 New… 
The New menu option is used to create a new 
project.  The .prj file will be stored in the directory 
shown in the Directory path at the top of the 
Project Manager dialog box.  When the New menu 
option is selected, the Create New Project dialog 
appears (shown at the bottom of the page). 
 
The Project Name can be any number of 
alphanumeric characters.  For MoDOT projects, 
the Project Name needs to be the same as the job 

number. (i.e. j1p0999.prj)  The Working Directory specifies the location of the project data 
files.  The Working Directory may be keyed in or the Select button may be chosen and the 
appropriate directory selected.  For MoDOT Bridge, the Working Directory should be set to 
t:\br-proj\A_Geopak\district\jobnumber\data. 
 
The next field is for typing in the 
COGO job number, or the Select 
button may be chosen and the 
appropriate COGO job number 
selected. 
 
Next the Preferences button 
should be chosen and the 
Project Preferences dialog 
appears, which is depicted on 
the following page. 
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The user may set the 
particular parameters for 
each project as well as the 
Working Directory.  
This keeps the user from 
re-setting them when 
changing projects since 
the project’s preferences 
are recalled when entering 
the project.  After all of 
the information is entered, 
select OK to accept the 
changes, or Cancel to 
reject them.  For more 
about User Preferences, 
see Section I.3 in the 
Introduction. 

 
Shown below is a sample project that includes a project description, which may be keyed in at 
the bottom of the Create New Project dialog box, with the Working Directory set to  
t:\br-proj\a_geopak\d5\j5p0100\data.  
 

 

2.4.2.1.2 Edit… 
The Edit menu option is used to change any settings associated with the currently selected 
project.  When chosen, the Project Info Edit dialog box appears. 

2.4.2.1.3 Delete… 
The Delete menu option is used to delete any project that has been stored.  The user highlights 
the project in the Projects and selects Delete. 
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2.4.2.1.4 Exit 
The Exit menu option closes the Project Manager and writes the settings to a resource file. 

2.4.2.2 Directory Tools 
There are two options under the Directory pull 
down, Create New Directory and Current 
Working Directory as shown.  
 
The Create New Directory option will create a 
new directory on the disk.   
 
If the Current Working Directory option is 
chosen, the directory path in Project Manager is 
changed to that directory. 
 
 
 
 
 
 
 
 
 
 
 

2.4.2.3 Administration Tools 
The Administration menu option is used to set a 
password on a project.  It is recommended that a 
password not be used since the project will need to 
be accessed by more than one user. 
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2.5 Project Users Dialog 

Once a project is highlighted and OK is selected, the Project Users dialog appears.  
 
This dialog has three sections: Project Users, 
User Info, and Description.  The Project 
Users list displays a list of users that have been 
created to work with any project that resides in 
the current projects home directory.  The names 
shown in Project Users will be the userid’s of 
the people working on that project as specified 
in the Start Job dialog.  Within the User Info 
group box, the Full Name field further 
identifies the user, and displays the full name of 
the user that is currently selected.  The OP 
Code field displays the GEOPAK Operator 
Code of the currently selected user.  The 
GEOPAK Operator Code is used for all 
coordinate geometry operations during this 
session.  The Operator Code, along with the Job 
Number, will be utilized whenever an input or 
output file is created by the software.  The 
Operator Code will be the user’s first and last 
initials.  The Description field displays the 
description of the currently selected user. 
 
Four tools are supported on the Project Users 
pull down as depicted in the exploded view to 
the right. 

2.5.1 New 
The New pull down menu option creates new users.  This option is not to be used in MoDOT.  
To create a new user for a project, use Start Job/Add User under the MoDOT menu with Add 
Userids to Existing Job activated, as show in the following figure.  Start Job/Add User must be 
used for the user to have the default MoDOT runs. 
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2.5.2 Edit 
The Edit pull down menu option allows the user to change any of the parameters of the currently 
selected user.  (Note: The User cannot be changed.  This will change the user information for the 
current project only.) 

2.5.3 Password 
The Password tool creates or modifies a password for the selected user.  If the selected user 
already has a password, the user will be prompted to enter the current password before 
continuing. 

2.5.4 Exit 
The Exit option closes the User dialog and returns back to the Project Manager dialog. 

2.6 Road Project Dialog 

After a minimum of one user has been defined, selecting the 
OK button on the lower left corner of the Project Users dialog 
or double clicking on a Project User will open the Applications 
dialog as depicted.   
 
When the Road option is selected, the following dialog appears.  
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2.6.1 General Description 
The top of the dialog displays the Working Directory, Working Alignment (if defined), User 
and GEOPAK Job Number.  In addition, a toggle for Working Alignment Influence Runs is 
also supported.  The bottom portion of the dialog box displays the various processes supported 
during the design process.  The small square in the upper right corner (to the right of the Job 
Number) will condense the dialog as depicted in the graphic below. 
 

 
 

2.6.2 Road Project Dialog Menu Bar 
There are three pull down menu bar options: 
File, Remember, and Options.  When the 
File option is selected, the choices are Close 
and Exit.  
 
If the Close option is selected, the user is 
returned to the Applications dialog.  If Exit is selected, the user is exited from Project Manager. 
 
When the Remember option is selected, the 
user can instruct the software to remember the 
Project, User, or Road in subsequent 
sessions.  For example, if all three toggles are 
activated, and the Project Manager is 
completely closed, the invocation of the 
Project Manager immediately invokes the Road Project dialog (flow chart) and utilizes the 
project name, username, etc., which were active when the Remember toggles were selected.  If 
only the Project and User toggles are activated, the user is returned to the Applications dialog in 
later sessions.   If only the Project toggle is activated, the user is returned to the Project Users 
dialog in subsequent sessions.  This option is particularly useful when numerous users are 
working on one project. 
 
The Options menu allows the user to toggle 
on the Autosink option.  When toggled on, 
this option will sink (move behind the open 
drawing views) the Road Project Manager 
dialog when a tool is chosen from the Project 
Manager.  When a tool is closed, the Road 
Project Manager dialog will become the active dialog.  
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2.6.3 Working Alignment 
The concept of a working alignment enables the designer to organize a project and to access 
project information without continually typing the required information.  On a simple project, 
only one working alignment may be needed.  However, on a more complicated project, an 
unlimited number of working alignments may be defined.  The designer can easily change from 
one working alignment to another by highlighting the desired alignment listed in the Select 
dialog.  Three tools relating to working alignments are located at the top of the Road Project 
dialog: 
 

• Select Button 
• Define Button 
• Working Alignment Influence Runs (toggle on left side of dialog) 

 

 
 

2.6.4 Select Option 
When the Select button is pressed, the Select Working Alignment dialog appears as depicted to 
the right.  If no working alignments have been defined, MoDOT appears in the Run List box.  If 
working alignments have been defined, they are listed with the last run time.  The description of 
the working alignment can be seen in the bottom of the dialog when each Name is highlighted.  
To select a previously defined working 
alignment, highlight the run from the list 
then press the OK button at the bottom of 
the dialog.  Double clicking on the Name 
also selects a previous working alignment 
for subsequent processing.  Pressing the 
Cancel button will close the Select 
Working Alignment dialog without any 
working alignment change.  Several file 
option are supported as depicted in the 
exploded view below.  These include New, 
Copy, Rename, and Delete.  
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• File>>New – allows the user to 

create a new working alignment.  
(Do not use this option as it will n
copy the default MoDOT setti
for the working alignment.  Instead, 
use Run>>Copy>>Run to copy the 
MoDOT run.) 

ot 
ngs 

hosen, 

on 

w 

 
• File>>Copy – allows the user to 

copy and existing Project, User or 
Run. 

 
• File>>Rename – allows the user to 

change the name of the existing 
working alignment.  

 
• File>>Delete – allows the user to 

delete an existing working 
alignment. 

 

2.6.5 Define Option 
Once a Working Alignment has been 
selected, pressing the Define button 
invokes the dialog depicted to the 
right.  The information that can be 
associated with a working alignment 
is listed in the left portion of the 
dialog box.  As each option is c
the right side of the dialog box will 
change to reflect the informati
needed as can be seen in the dialog 
box to the right after Profile Vie
was selected.  
 
All information entered in these fields 
can be used in subsequent processes 
run from Project Manager.  In the 
beginning of a project, much of this 
information will not be known but, as 
the user goes through the deign 
process, it can be added to the 
working alignment definitions.   
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For example, as soon as the chain 
has been stored in COGO, the user 
can enter that information in the P
View fields as depicted to the right.
For a more complete explana
each option shown, please see the 
GEOPAK Manual. 

lan 
  

tion of 

 
 
 
 

2.6.6 Port Viewer 
The Port Viewer is a tool that enables the user to view all three major aspects of a road design 
simultaneously even though they are located in different files.  The three views include: 

• Plan 
• Profile 
• Cross Section 

As a prerequisite to invoking the Port Viewer, a working alignment must be defined with the 
following information. 

• Alignment Specification 
• Plan View Design File and Chain 
• Profile Information 
• Cross Section File 
• Digital Terrain Models 

The Port Viewer will be covered in more detail in Chapter 16 in the GEOPAK Road 2 part of 
the manual. 
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2.7 Project Manager Process 

The primary Project Manager dialog is depicted below.  The advantage of utilizing the Project 
Manager rather than selecting functions directly from the Road menu is that pertinent 
information stored within the Project Manager is automatically displayed within the invoked 
dialog.  Therefore, job numbers, chain names, stationing, file names, and data associated with the 
project do not have to be typed in each time a dialog is utilized.  However, the user can change 
information in the fields. 
 

 
 
Many of the Project Manager processes function identically to their corresponding dialog’s 
invocation from the Road menu.  However, some of the procedures will invoke the Select Run 
dialog prior to invoking the actual dialog.  The Select Run dialog allows the user to set up 
different options to use in alternative design choices. 
 
Each of the Road Project dialog processes will be covered individually in the separate remaining 
chapters. 

2.7.1 Select Run Option 
When certain procedures are selected from the Project Manager dialog, the Select Run dialog 
will be invoked.  The Select Run dialog allows the user to save the settings for each procedure in 
a Run that can then be recalled whenever the user needs to execute that procedure.  With the 
individual runs, a user can keep a history of the project, and can access the various procedures 
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with the settings that were previously used.  
This way a user can repeat various 
procedures with the same settings 
previously used.  
 
When the Select Run dialog is invoked, 
MoDOT appears in the Run List box.  
(Some Select Run boxes will display 
default run names such as English, Metric, 
I_XS_10, etc.)  If Runs have been defined, 
they are listed with the last run time.  The 
description of the Runs can be seen in the 
bottom of the dialog when each Name is 
highlighted.  To select a previously d
Run, highlight the run from the list, and 
then press the OK button at the bottom o
the dialog.  Double clicking on the Name 
also selects a previous Run for subsequent processing.  Pressing the Cancel button will close t
Select Run dialog without any run settings change.  Several file option are supported as d
in the exploded view below.  These include New, Copy, Rename, and Delete.  
 

efined 

f 

he 
epicted 

• File>>New – allows the user to 
s 

e 

 
 File>>Copy – allows the user to 

 

 
 File>>Rename – allows the user to 

 
 File>>Delete – allows the user to 

create a new run.  (Do not use thi
option as it will not copy the 
default MoDOT settings for th
procedure selected.  Instead, use 
Run>>Copy>>Run to copy the 
MoDOT run.) 

•
copy and existing Project, User or
Run. 

•
change the name of the existing 
Run.  

•
delete an existing Run. 
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Exercise 2-1 

This is an individual exercise to practice setting up the directory structure and files for a new 
GEOPAK job. 
 

1. Open any MicroStation file. 

 

2. Create the following job with the Start Job dialog (MicroStation menu path: 
 
 MoDOT > Start GEOPAK Job/Add User).  
 
Use the settings shown in the following dialog. 

 

 
 

3. Review the directory structure and the files created in the directory.  
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4. Use the Project Manager dialog to create the following project:  
 

Go to the directory t:\br-proj\A_Geopak\D3\j3p0497\project\ 
 

 
 

Choose Projects>>New.   
 

 Enter the following information in the Create New Project dialog as shown below. 
 
Project name: j3p0497 
Working Directory: t:\br-proj\A_Geopak\D3\j3p0497\data 
Job Number: 497 

 

 
 Set up the Preferences as shown below: 
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5. Add User2 and User3 as users to the project.  
 

 

A) Start by 
toggling on 
Add 
Userids to 
Existing 
Job.

B) Continue 
by using 
this 
Browse 
button to 
choose 
the Job 
Number 
and Path.

C) Select the 
USERIDS 
to be added. 

D) Click OK 
to finish 
the 
process. 
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Exercise 2-2 This is an individual exercise to practice setting up a new working alignment. 

1. Open the Microstation file t:\br-proj\a-geopak\d2\j2p0300\data\topo_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a-geopak\d2\j2p0300\project\j2p0300.prj. 
 

 
 

3. Select userc as the Project User. 
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4. Select the Road Project.  

 
 

5. Click on Select button at the top of the Road Project dialog as depicted below. 
 

 
 

In the Select Working Alignment dialog that appears, select the menu option:  
 Run > Copy… > Run. 

 

 



GEOPAK Road for Bridge  Ex. 2-2 Working Alignment Setup 

11/19/02 Missouri Department of Transportation 2-2-3 

 This will display the Select Run to  
Copy From dialog shown to the right.   
Select the default MoDOT run and  
click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Enter J2P0300 in the new Run  
Name field as depicted in the figure  
to the right and click OK to create  
the new run. 
 
 
 
 
 
 

 
Select the J2P0300 working alignment  
as shown below and enter the alignment  
by clicking OK. 
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6. Enter the working alignment definition by clicking on the Define button to the right of the 
Select button in the Road Project dialog as shown below. 

 

 
 

7. Set up the default DGN files for the J2P0300 project as shown below: 
 
In the Plan View section, change the Design File to plan_j2p0300.dgn. 
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 In the Pattern section, change the Design File to pattern_shape_j2p0300.dgn. 
 

 
 

In the Shapes section, change the Design File to pattern_shape_j2p0300.dgn.  
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 In the Profile View section, change the Design File to profile_j2p0300.dgn.  
 

 
 

Save the changes to the working alignment definition by clicking OK.  This default 
alignment for the project will be modified and used as the basis for other parts of the project 
in later exercises. 
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